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Introduction

This manual builds on the VectorWorks Essential manual. The Essential manual is 
designed to show you basic concepts of VectorWorks such as 2D drafting, simple 3D 
modelling and basic file organisation. If you are unfamiliar with these concepts then you 
should get the Essential manual and complete it before you go any further. 

In this manual we will be working through a few of projects:

• the first project will work through a quick domestic project where we have a 
sketch plan and we want to add some plants and hard landscaping to the plan;

• the second project is similar to the first project but we will start with a blank file 
and work right though the process from importing the scanned image to putting 
the title block on the drawing;

• a small commercial project that needs planting quickly added to the developer’s 
site plan;

• a full domestic project for a client, the Smith Family, where we will plan a garden 
that will include planting, irrigation, hardscaping and an outdoor structure. This 
project will be in 2D and 3D. 

 
In Project 1 we will open a file that has a sketch already in it. Then we’ll draw a 
landscape plan on top of the sketch, add some hard landscaping and some notes to finish 
the drawing. The aim of this exercise is to show you how quick and easy it is to create 
your landscape plans and then show you how easy it is to count the plants and quantify 
the hard landscaping. 

Project 2 is similar to Project 1 but we will go into more detail. We will start with a 
blank file and then we will import the scanned image of the site, add the trees and hard 
landscaping. Along the way we will edit the plants to suit us, and we will add a tile 
block to the drawing so that so can start to use this method to 

For the commercial project we will import the developers plan, add the planting to suit 
the council requirements, tag the plants so that the council knows what plants we have in 
mind and quantify the area of landscaping so that we can show that we are in accordance 
with the council requirements. 

In the last project we will design a landscape for a young family. Gina and Dave Smith 
live in a 1970’s 3 bedroom timber frame house on a concrete block basement garage. 
The house is facing north on a gently sloping 1/4 acre section. The house is located in 
Auckland, New Zealand, so the north sloping site is ideal for this house. The client has 
been living in the house for 5 years. They now have two children, one boy, 11 years old 
and his sister 8 years old. The children are wanting more separation from their parents, 
and in the future they will want to be more independent. An Architect is remodelling the 
house and we have to base our landscape on the architect’s proposals. We will import the 
plan from the architect, draw the house from our site measurements, create the 3D terrain 
and modify it, create and place our own plants and create some landscape structures. 
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 How to Use this Manual

Here are some things that will help you to use this manual better:

• Spend the time to work through the manual.  The information in this manual will 
not find it’s way into your head if you don’t complete the exercises.  Reading the 
manual is good, reading the manual and watching the movies is better, reading 
the manual, watching the movies and completing the exercises has the best 
results. Watch the movies, try the exercise and then play the movie again. 

• Instructions for you to complete are shown like this.

Tips: 
Useful tips are shown like this

Measurements for you to use are shown in both Metric and Imperial. Metric 
measurements are shown first, Imperial measurements are show second in brackets. 
If you are  using metric, don’t type in the imperial measurements; if you are using 
imperial, don’t type in the metric measurements, just type in the measurements inside 
the brackets.

This manual comes as a hard copy with 1 CD.  

There are two exercise folders on the CD. One is called “Imperial Landmark Exercises”, 
the other is called “Metric Landmark Exercises”.  Copy the exercise folder that you 
want to use to your computer.  Place the exercise folder in a location to make it easy to 
open the files, such as “My Documents”.

Save any training files that you work on to your exercise folder.

When you want to play a movie that is shown in the printed manual, insert the 
VectorWorks Landmark CD into your computer’s CD player and double click on the file 
on the CD called “Landmark Manual.pdf”.  This is your electronic copy of the manual 
and it contains links to all the movies.  To play a movie from the electronic copy of the 
manual, move your cursor over the movie icon (the cursor changes shape) and click 
once.  When the movie is finished it will automatically close.  

Use Adobe Arcobat Reader to read the manual and play the movies, use VectorWorks to 
do the exercises. 
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Project 1 Domestic Project

This project is designed to show you how quick it can be to draw the plants 
and hard landscaping once you have all the information that you need. 

• Open the file Project_1.sta 
from the exercise folder. This 
file has a scanned image of 
our landscape plan already 
imported into it. All we have 
to do is to add the plants and 
hardscape. 

• Choose the Place Plant tool 
from the Site Planning Tool set.

• Click on the Plant Tool Settings button. 

• This opens the dialog box where we choose 
the plant that we want to place. You can set the 
size of the plant, the type of plant, spacing and 
height. 




12 ©Jonathan Pickup

• Close the worksheet.

• The worksheet shows on the 
drawing. 
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Project 2 Domestic Project

Step 1 Layer and Model Setup

Document Setup
We will set up the file from the beginning, from a blank document, import the scan of 
the site, add the trees and draw the hard landscaping. We will work through to getting 
the drawing ready to print. VectorWorks has setting up commands to make it easier to 
set up the file.  When you have set up the file it can become a template file that you can 
use to start every new job, saving you a lot of time in setting 
up...

• From the Menu Bar choose 
File > New...  

• This opens a dialog box for you to choose Blank 
Document 

• A blank file opens with a 
layer scale of 1:1 and a letter 
size page. If you are using 
the Australia/NZ version of 
VectorWorks then a metric file 
opens.

• Let’s set up our page first...
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• The Document Setup dialog box now shows 
you your settings...

• Click on the OK button.
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Step 3 Import a Scanned Image.Import a Scanned Image.

In this project we will import a scanned image. Then we’ll use the scanned image to add 
the plants and hard landscaping. This is very similar to the 1st project but we will go 
into more detail for this project. 

• From the Menu bar choose 
File > Import > Import Image File...

• Import the Project 2.jpg file from the exercise 
folder. 

• The scanned image is about 
1:200 scale so we don’t need to 
do anything else to this image. 

• Drag the site scan so that it’s in 
the middle of the drawing. 
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Step 4 Placing Standard Plants

This is where we put plants on the drawing. 

• Change Layers to planting (ie. Make planting the active layer).

• Choose the Place Plant tool from the Site Planning Tool 
set.

• Click on the Plant Tool Settings button. 

• This opens the dialog box where we choose 
the plant that we want to place. You can set the 
size of the plant, the type of plant, spacing and 
height. 

• Click on the plant and a series of plants appears. 
Choose the one of the plants. You might not see 
the same plants as I have in this picture. The 
plants shown are saved in a file in the Libraries 
folder. You can edit this file to speed up placing 
plants. 

• Change the Spread, Height and Spacing. 

• Click on the OK button to close the dialog box. 
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Step 5 Editing Plants

Using the standard plants is all very well, but the graphic style may not suit you. We can 
edit the plan shape of the plants. If we edit the plants in the right place you will change 
the plants for every project from then on. 

• Open the file: 
VectorWorks 12.0.0/Libraries/Defaults/Plants - 2D Symbols/
2DPlantSymbols.mcd 

• When this file opens, point the 
Resource Browser to look at 
this file.

• Right Mouse click (ctrl-Click on a one button 
mouse) on the first symbol, PTemp2D-01.

• Choose Edit from the pop-up menu. 
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• Choose to edit the 2D Component. 

• Click on the OK Button. 

• Now you can see the part that will 
define your plant. 

• Delete the parts that you don’t want. 

• Draw the shape that you want. From 
now on every new project will be able 
to use this shape to make plants. 

Beware of making your 2D shape 
too complex as it will slow down your 
drawing. 

• Click on the Exit Symbol button at the top right hand 
corner of the screen. 

• Save your file.

• You can see the new plant in the Resource Browser. You 
don’t use it from here, but you can see it. 

• If you edit each plant you can set up a whole file that has 
just the plants that you want. 



©Jonathan Pickup 33 

Step 6 Editing Plant Data

Editing plant data can be done in two ways; one inside of VectorWorks and the 
other way is to edit the plant data outside of VectorWorks using excel to edit 
the spreadsheet. We will look only at the first method, as the second method 
has to be tackled very carefully.

• Delete the plants that we placed 
earlier. 

• Select the Place Plant tool 
from the Site Planning Tool set.

• Click on the Settings Button, 
the last button on the Mode Bar 
so that we can set up our plants. 

• Click on the New Plant... button. 

• This takes use to a dialog box where 
we can set up and edit our plants. 

• Click on the 2D Symbol button 
to choose the plant symbol that 
you want. If you have edited 
all the plants as I suggested in 
the last step, you will have your 
plants to choose from. 
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Step 7 Hardscape

Hardscape is a special tool that makes it easy to draw areas of paving. This hardscape 
can be 2d only, or it can be 2D and 3D. If you make it 3D, then it can be a site modifier 
and can affect the site model. 

• Zoom in to the south area of the 
house.

• Choose the Hardscape tool from the 
Site Planning Tool Set.  With this tool you draw a shape 
for the hard landscaping and VectorWorks fills in the 
hardscape using the details that you enter.  

• Click on the Hardscape tool 
Preferences... (the last button on the 
Mode Bar). 
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• Click once where you started the 
hardscape. This should complete the 
polygon.

• VectorWorks fills in the hard 
landscaping. 

• If the hardscape obscures the planting, 
right mouse click (control- click on a 
one button mouse) on the hardscape 
and choose: 
Send > Send to Back.

• Create more hardscaping. Turn on the 
tags and change the Hardscape name 
to something that will be descriptive. 
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Step 8 Drawings and Annotation

Drawings without annotation are incomplete. This section shows you how to add a title 
block.

Standard Title Blocks (Drawing Border)

• Click once on the Drawing Border tool from the  
Dims/Notes Tool Set. 

• When you move your cursor into the 
drawing area you will notice a ghost 
image of a title block on your cursor.  

• Double click to place the drawing 
border (title block). Don’t worry about 
lining up with the drawing area. 

• Click on the option for 
Lock to Page Centre. 
This means that you don’t have to be careful where you 
put the title block. 

• On the Object Info Palette click  on the Title Block... 
button. This allows you to choose a sample title block to 
use as the basis of your title block. 
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• Click on the Edit Title Block... button on the Object Info 
Palette. 

• Fill in the drawing name, drawing number and 
so on.

• Click on the OK button. 

• Notice that the information is added to 
the drawing border.

• Now you can see that our title block 
is in conflict with the sections, so they 
have to be moved.

• If you don’t want the revision 
information, turn it off on the Object 
Info Palette.
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Project 3 Commercial Project
In this project we will import a drawing from a consultant that shows the existing site and 
proposed new development. Your job is to quickly show that there is enough landscaping on the 
project and provide a price for the planting. 

Step 1 Layer and Model Setup

Document Setup
We will set up the file from the beginning, from a blank document. VectorWorks has 
setting up commands to make it easier to set up the file.  When you have set up the file 
it can become a template file that you can use to start every new job, saving you a lot of 
time in setting up...

• From the Menu Bar choose 
File > New...  

• This opens a dialog box for you to choose Blank 
Document 

• A blank file opens with a 
layer scale of 1:1 and a letter 
size page. If you are using 
the Australia/NZ version of 
VectorWorks then a metric file 
opens.

• Let’s set up our page first...
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• The Document Setup dialog box now shows 
you your settings...

• Click on the OK button.



©Jonathan Pickup 53 

Step 2 Import DXF/DWG File (Architects Plan)

There are often times when you need to import a file from a consultant. A site survey, 
road layout, etc that you need to work on top of. Exchanging digital information 
between consultants is becoming common.  Chances are that your consultants will be 
using a program other than VectorWorks and you will have to share information in  a 
form that both your CAD program and your consultant’s program understands.  Sharing 
information will involve translating your VectorWorks files into a format that your 
consultant’s program can understand and translating your consultant’s files into a format 
that VectorWorks can understand, this file format is called DXF or DWG.  

Often this file translation is easy but sometimes it still causes some confusion.  The 
aim of this exercise is to explain the options available to make these translations as 
straightforward as possible, in other words how to keep the translations as consistent as 
possible.  

Importing
Never, never, never, import the DXF/DWG file into your existing project file. It may 
seem that we are doing just that, but remember that we only started the file in the last 
step, so it is still a new file. 

I know that it seems a good idea to import the DXF/DWG file into your existing file, but 
don’t do it. The imported file can change all your dashed line styles...

• From the Menu Bar choose 
File > Import > Import DXF/DWG...
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Step 3 Placing The Landscape Areas

We have our plan imported and it’s 
time to plant our plants and landscape 
areas. If you place the plants first and 
the coloured landscape areas later, 
then the landscape areas would cover 
all the plants. It’s easier and quicker to  
place the landscape areas first. We can 
assign the landscape areas to a class 
and then count the areas to show the 
council that we have the right area of 
planting and trees. 

• Use the 2D Polygon tool to trace 
around the whole site. The we need to 
put the boundary on a class to control 
the graphics and  to allow us to count 
the site area with a worksheet. 

• You will need to create a new class for this, 
name the class 
Landscape-Site Boundary.

• Then assign the boundary to the Landscape-
Site Boundary class using the Object Info 
Palette ..
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Project 4 Full Domestic Project

Step 1 Layer and Model Setup

Document Setup
We will set up the file from the beginning, from a blank document. VectorWorks has 
setting up commands to make it easier to set up the file.  When you have set up the file 
it can become a template file that you can use to start every new job, saving you a lot of 
time in setting up...

• From the Menu Bar choose 
File > New...  

• This opens a dialog box for you to choose Blank 
Document 

• A blank file opens with a 
layer scale of 1:1 and a letter 
size page. If you are using 
the Australia/NZ version of 
VectorWorks then a metric file 
opens.

• Let’s set up our page first...
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• Double click on the Mod-Building layer, the 
one we’ll use to build the house.

• Change the Delta Z to the height of the walls 
that you measured on site, from the Floor to the 
ceiling. 

• Click on the OK button

• This takes you back to the 
Organization Palette, where you can 
see the changes to the layer heights. 

• Click on the OK button

• If you haven’t saved your file save it 
now.
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Step 4 Create the Site Model

Creating a 3D site model and a 3D building is an area of VectorWorks that really shows 
the advantage of working in 3D. With the site model we can visualize the site, the 
height to boundary or recession line constraints, the sun position relative the site and the 
shading that other buildings, trees and parts of the site will have on your building.

Building a site model gives the ability to see on the screen what the constraints on your 
site are. You can use the site model to help sort out the bulk and location on the site, 
which is what we will be doing with our project.

Think of it this way. You have a tricky site with tight height to boundary problems. You 
build a Site Model you can quantify the constraints. You can build a mass block model 
and sort out exactly how much you can build and where you can build it. Using a Site 
Model can help you to resolve the levels on the site as well as resolving the area that 
you can build. When you have sorted out the bulk and location you can refine the design 
and use the recession planes when you submit your drawings to the council.

What is a Site Model
A site model is a way of looking at 3D data (spot levels or contours) in a way that 
allows you to see complex 3D models and 2D representations. VectorWorks uses the 3D 
information to create the models based on the data to help you understand the 2D and 
3D nature of your site.

How Does It Work?
First you have to put in some 3D data, such as spot levels, contours or surveyor’s data 
file. Then you ask VectorWorks to create a site model from this data. VectorWorks 
uses a set of algorithms to analyse the information and then creates the 2D and 3D 
representations. The algorithms can be thought of as a set of mathematical assumptions 
that are used to calculate the 2D contours and 3D model. Because of these assumptions 
you may get some odd shaped contours, or 3D models that don’t look as you expected. 
A Site Model is not reality, it’s a mathematical model of the data you give VectorWorks. 
Better data - better Site Model.

When you create a Site model VectorWorks will make a Plug-In Object that can show 
one type of information in a 2D view (2D contours) and a different type on information 
if you are in 3D view (3D contours or extruded contours etc.). Using this hybrid object 
is a good way of combining the 2D contours and the 3D site model into one object. If 
you are used to earlier versions of VectorWorks then this will be a very different way of 
working). The Plug-In Object allows you to turn on or off the existing and proposed  site 
models. 
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• This is a common way to create a site model, but it’s not the only way. Another 
common method is where you have a surveyor measure the site for you and 
send you a file that contains all the site information and 3D contours, refer to 
Appendix 3 - More Site Modelling.

• If you haven’t saved your file save it now.
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Step 5 Create The Walls

Now that we have the site drawn, or (modelled), we need to draw the building so that 
we can make sure that our landscape is appropriate to the house. That’s what this section 
is about, how to make the building. 

We will draw the building using walls. Why use walls? First, most of you are drawing 
buildings and so need to show walls in plan.  There are 2 ways to do this, either by 
drawing 2 lines to represent the wall, or use the wall tool that will draw all the lines 
and cavities on the wall that you specify.  The wall tool makes it fast to draw a plan of a 
building.

For most Landscapers and Designers the wall tool is fundamental to 3D work.  Mainly 
you will be drawing plans to describe the work to be carried out.  The wall tool not 
only draws the 2D portions of the walls with cavities, but also uses the layer heights to 
extrude the walls in 3D for you.  This is why it’s important to set up the layers first.  

If you need more information on joining walls, healing walls and creating 
walls refer to the Appendix 3 - Dealing With Walls. 

Create The Walls
• Change layers to Mod-Building.

• Change the layer options to Active Only.

• Use the Navigation Palette for this. It’s quick! 

• Use the Rectangle too to draw 
the rectangles to the dimensions 
shown in this picture. Don’t 
draw the dimensions, they are 
just there to show you how big 
to make the rectangles. 

• If you are struggling with this 
part, go back to the Essential 
Manual to learn how to draw 
simple shapes. 
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Step 6  Creating  The Roof

We need to create a roof for for the house so that it reflects the existing house. 
That way, when we create a 3D view of our landscape the client can see that 
you took notice of the existing house in your design. 

Create the Roof 

• All your existing walls should be 
selected. If they walls are not selected, 
select them using the 2D Selection 
Tool. 

• From the Menu bar choose 
AEC > Create Roof...

• Put in the settings for the roof.

• Click on the OK button.
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Step 7 Doors and Windows

VectorWorks doors and windows are created using the Door or Window 
object. When you create a door or window you are making both the 2D 
portion and the 3D portion. 

• At the moment we can’t see our walls, 
all we can see is the roof. 

• Right mouse click (ctrl-click on a one 
button mouse) on the roof. 

• Choose Send > Send to Back from 
the contexural menu.

• Now you can see the walls.

• From the Building Shell tool set choose the Door object.

• Click on the Door Preferences, the 
last button on the mode bar.
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For a real project you 
would place as many of 
the doors and windows 
as you need to show the 
existing building. For a 
quick project I only show 
the doors and windows that 
open out to the garden. 
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Step 8 Floors

A floor in VectorWorks is a hybrid object. This means that there is a 2D portion and a 
3D portion. The Floor command takes a user defined 2D shape (polygon, rectangle, oval 
etc.) and creates a 3D Component based on this.  You have the option of defining the 
height in the current layer to the bottom of the floor and the thickness of the floor.

In our file we have 3 rectangles that we used to create our building outline. We can use 
these to create floors.

• Select the 3 rectangles that we drew at 
the start of drawing the house. If you 
have deleted them or can’t find them, 
draw 3 new rectangles. 

• From the Menu Bar choose 
AEC > Floor...

• Set the Bottom Z (the underside of the floor) to 
600mm (2ft.)

• Click on the OK button. 
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• The new floor objects come to the 
front (all new objects come the front).

• Right mouse click (ctrl-Click if you 
have a one button mouse) and from 
the context menu choose: 
Send > Send to Back. 

• Now you can see the walls and roof 
correctly.

You can use this floor concept to 
create any slab type object, such as 
floors, benches and so on. 
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Step 9 Link House to Site

Now that we have the building we need to link it to the site plan. If you copy and paste 
the house onto the site plan, it will not update if you make any changes to the house. 
Layer linking allows you to update the house and have the site plan automatically 
update. 

• Change layers to the Mod-Site Plan layer. The 
Navigation Palette make this really easy. 

• You can see the site plan and 
the site model, but our house is 
not here yet. Layer linking will 
bring our house into our site 
plan. 

• From the Menu Bar choose 
View > Create Layer Link...
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• Move the house in the Z direction only. Move 
the house up 4250mm  
(14 ft.) 

• Now that looks better.

• If you haven’t saved you file lately 
save it now. 
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Step 10 Placing Standard Plants

All our work so far has been to get the plan of our existing house set up. Now we can 
start to get the plants on the drawing. We will go into some detail about this so that I can 
teach you how to make your own 2D plant graphics, how to make your own 3D plant 
symbols and where to store them. If you want to use the standard plant symbols that’s 
OK, just ignore what I say about editing the plants. 

• Change the view to a Top/Plan view.  
You can use the Menu bar to change 
the view, or you can use the 0 key on 
the numeric keypad. 

• Choose the Place Plant tool from the 
Site Planning Tool set.

• Click on the Plant Tool Settings button, the last 
button on the mode bar. 

• This opens the dialog box where we choose 
the plant that we want to place. You can set the 
size of the plant, the type of plant, spacing and 
height. 
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Step 11 Editing Plants

Using the standard plants is all very well, but the graphic style may not suit you. We 
can edit the plan shape of the plants, we can edit the classes in the plant symbol (which 
would help when you want to move from concept drawings to working drawings. If we 
edit the plants in the right place you will change the plants for every project from then 
on. 

• Open the file: 
VectorWorks 12.0.0/Libraries/Defaults/Plants - 2D Symbols/
2DPlantSymbols.mcd 

• When this file opens, point the Resource Browser to look 
at this file.

• Right Mouse click (ctrl-Click on a one button 
mouse) on the first symbol, PTemp2D-01.

• Choose Edit from the pop-up menu. 
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• If you edit each plant you can 
set up a whole file that has just 
the plants that you want. 

• This is the Concept view. I’ve 
turned off the construction and 
canopy above classes. 

• This is the Construction view.This is the Construction view.

• This is the Canopy Above view.This is the Canopy Above view.

• Now that we have our plant graphic in a way that suits us, we can go back to our 
project and add some real plants, with real plant data. 
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Step 12 Editing Plant Data

Editing plant data can be done in two ways; one inside of VectorWorks and the 
other way is to edit the plant data outside of VectorWorks using excel to edit 
the spreadsheet. We will look only at the first method, as the second method 
has to be tackled very carefully.

• Delete the plants that we placed 
earlier. 

• Select the Place Plant tool 
from the Site Planning Tool set.

• Click on the Settings Button, 
the last button on the Mode Bar 
so that we can set up our plants. 

• Click on the New Plant... button. 

• This takes use to a dialog box where 
we can set up and edit our plants. 

• Click on the 2D Symbol button 
to choose the plant symbol that 
you want. If you have edited 
all the plants as I suggested in 
the last step, you will have your 
plants to choose from. 
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Appendix 1 Layer and Class Standards

When you create a lot of drawings it’s essential that your drawings are similar to each 
other in the way they are set up.  The best way to ensure that the drawings are consistent 
is to use a layer and class standard to make sure that you are using the same layer names, 
the same class names and the same class settings in each project.  

VectorWorks comes with a layer and class standard concept and you can use this to 
set up your own layer and class standards. You do this by creating a file with all your 
standard layer names and class names with the attributes in it and saving it in the 
Standards folder.  

When you create a new class you will be able to choose new classes that match your 
office standards and when you create a new layer you will be able to choose new layers 
that match your office standards.

Let’s make a sample standard file to see how it works.  Then as we develop our house 
project we can use our layer and class standards to create our layers and classes for our 
project.

•	 Create	a	new	file,	using	the	blank	document.		

• From the  Menu Bar choose File > Document 
Settings > Document Setup...

• Set up the as we did earlier in the manual.  
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Appendix 2 - Drawing Complex Site Plans

Open a new file so that we can draw the site boundaries or property lines. 
Generally when you start a new project you would get the site information 
that you have. This could be a certificate of title, surveyor’s drawing or measurements 
that you have taken on site. We have a plan of the site to work from.

• Change the layer scale to 1:250. 
• Select the Property Line tool 

to draw the site.

• Click on the Preferences Button 
on the Mode Bar to set the 
preferences to Bearings, and 
turn off the simple dialog. 

• Click once on the screen to start 
and	the	Define	Property	Line	
dialog box opens. I always start 
at the end of the arch segment, 
so that if I mess up, at least I 
have most of the site, and I only 
have to tidy up the arc segment. 

• You type in the distance and use the surveyors bearings as they are shown on 
the information that you have. If the bearing is going the same direction as the 
surveyor measured type in the bearing.

 
• If the bearing is going opposite to the direction surveyor 

measured type in the bearing but enter the length as a 
negative. Where to start is always important. I always 
start at the end of an arc. That way, if I mess up the arc, it 
is	the	last	segment	and	could	be	finished	manually.

• We will start at the bottom end of the arc. Click in the 
drawing area to start.
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•	 For	this	example	choose	the	file	spots.txt  from 
the Architect Exercise Folder.  

•	 VectorWorks	then	shows	you	the	first	line	of	the	
selected	file	so	that	you	can	check	the	file.		This	
text	file	is	set	up	to	use	X,Y,Z	coordinates.		

• Check to make sure that you have Easting, Northing, 
Elevation chosen.  

•	 The	text	file	uses	mm	for	the	coordinates.		You	should	
check	the	file	format	and	coordinates	when	you	ask	the	
surveyor	to	give	you	this	type	of	text	file.		

•	 VectorWorks	will	check	the	text	file	that	you	are	
importing and report any errors.

•	 If	you	haven’t	used	this	file	for	importing	survey	data,	
VectorWorks will show you the preferences for the Stake 
Object.

• The Stake Object is an object that represents a spot level, 
and it displays its vertical height.  If you move the object 
up or down in 3D, the text on the stake object changes 
accordingly.  

• Click on the OK button.

Now that you have imported the survey data 
you can make the site model.  You make the 
site model the same way that we made the 
last one.

• From the Menu Bar choose  
AEC > Terrain > Site Model...

• Make the site model as we did in the 
last exercise, setting the properties as 
we did in the last exercise.
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Appendix 5 - Dealing With Walls

Joining Walls

•	 Open	the	file	Wall_1.sta from the exercises folder.
 There are  4 groups of walls similar to the picture. 

• Select the Wall Join Tool.  

• There are 3 modes for the join wall tool and 2 options for 
the cap on the end of the walls that you join.  

•	 The	first	mode	is	for	T joining walls, the second mode is 
for corner joining walls and the third mode is for joining 
walls that cross each other.  

•	 When	you	select	a	mode	from	the	first	group	
you then need to select a mode from the second 
group to tell VectorWorks whether the walls are 
butt joined (with caps) or mitre joined (without 
caps).

•	 To	use	any	of	the	wall	joining	modes	click	on	the	first	wall	to	join	then	click	on	
the second wall to join.  When clicking on the walls it doesn’t matter where on 
the wall you click, you don’t have to click on the point that you want to join.  
Avoid clicking on a point where two walls come together, you will not know 
which wall VectorWorks will choose.

•	 On	the	first	group	of	walls	we	will	use	the	first	mode.		The	first	mode	is	for	T 
joining walls.  If one of the walls pass beyond the other (even by a small amount) 
then the join will be a T joint.   

•	 Select	the	first	mode	then	select	the	uncapped	mode	(the	first	mode	in	the	second	
group).  This will create a seamless joint in the two walls.
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•	 This	technique	has	a	similar	result	as	the	first	
method, but it is quicker.
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Appendix 6 - Dealing With Roofs

Editing Roofs

Split Gable Roof

Once a roof is created you can edit parameters of the roof, roof plane by roof plane if 
you want, or the entire roof. We are going to create a split gable roof using the standard 
roof command, and some simple editing. 

•	 Open	the	file	Roof_01.sta from the exercises folder. 

• Select the roof using the 2D Selection 
tool.  

• When you create a roof the result is 
always a hip roof but we want a split 
gable.  

• With the 2D Selection tool move the 
cursor over the handle at the right 
hand side of the roof.  

• When you do, the cursor will change 
into a hand.  

• Click on the handle to open the Edit 
Roof dialog box.

• Click on the Gable radio button.

• Click on the OK button.  
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